The importance of on-time response and monitoring in Advanced metering infrastructure (AMI) and distribution automation networks increases demands on reliable communications. Standards-based communications are becoming a requirement in most smart grid deployments as service operators and regulators take advantage of interoperability. This TI Design addresses these issues by implementing a solution with standard-based wireless M-Bus and G3-PLC power line communication (PLC).

This design may help improve network performance, reliability, capacity, and scalability. The CC13xx wireless MCU acts as both the RF protocol processor and the host for the PLC processor, resulting in additional cost-saving for the system design. This design is based on a wireless M-Bus RF solution with G3-PLC. To view a TI proprietary RF solution-based version, refer to the TIDC-HYBRID-RF-PLC Design.

**Design Resources**

- TIDC-HYBRID-WMBUS-PLC Design Folder
- CC310 Product Folder
- F28PLC84 Product Folder
- F28375S Product Folder
- F28M35H52C Product Folder
- AFE031 Product Folder
- AFE032 Product Folder
- TMDSPLCKITV4-CEN Tools Folder
- CC1310DK Tools Folder
- TI-PLC-G3-CENELEC-SN Tools Folder
- CC13XX-SW Tools Folder
- WMBUS Tools Folder

**Design Features**

- Improves Network Reliability Through Simultaneous Transmission Over Wireless M-Bus and PLC Networks
- Improves Network Capacity Through Spatial Multiplexing by Using Wireless M-Bus and PLC Networks to Simultaneously Transmit Independent Data
- Improves Network Scalability by Acting as Bridge Between Wireless M-Bus and PLC Networks, Extending Area Covered Within Territory
- Fully Programmable Protocol Design Provides Various Options for PLC/Wireless M-Bus Communication Protocols (PRIME, G3-PLC, and PLC-Lite) Over CENELEC, ARIB, and FCC Frequency Bands and Wireless M-Bus C-/T-/S-Mode TX/RX Support Over 868-MHz Frequency Bands

**Featured Applications**

- Distribution Automation
- Smart Meters
- Smart Plugs
- Smart Grid Communications
1 System Description

This design provides a reliable communication system solution with standard-based wireless M-Bus and PLC communications for end equipment of smart grid applications. This design is built on top of the existing TI PLC and wireless M-Bus solutions, which improves network performance and provides more features by combining the communication modems and the inherited advantages from the existing PLC and wireless M-Bus solutions.

The ARM® Cortex™-M3 processor in the CC1310 Simplelink™ wireless microcontroller (MCU) is the CPU that controls the RF and PLC links. In this design, the CC1310 Wireless MCU is connected to the C2000 PLC MCU through UART and acts as the external host processor for the PLC modem. The PLC MCU is loaded with the G3-PLC stacks. The wireless MCU also runs the host applications for the system by simultaneously transmitting packets on both networks or acting as a bridge between the different physical networks. Section 4 describes the hybrid wireless M-Bus PLC example project that uses this architecture.

Figure 1 shows the wireless M-Bus with a G3-PLC full-stack based system architecture.
2 Block Diagrams

The primary devices for this design are CC1310, TMS320F28PLC84, and AFE031. The CC1310 includes two core processors: ARM™ Cortex-M0 for RF communication and ARM™ Cortex-M3 for applications, network stacks, and host-level RF/PLC communication drivers. The TMS320F28PLC84 with AFE031 (PLC analog front end) is for PLC communication.

Figure 2 shows the block diagram.

![Block Diagram](image_url)

2.1 Highlighted Products

The Reference Design features the following devices:

- CC1310 combines a flexible, low-power RF transceiver with a powerful 48-MHz ARM™ Cortex-M3 microcontroller in a platform supporting wireless M-Bus stacks.
- TMS320F28PLC84 provides optimized PLC OFDM performance with VCU and allows programmable, flexible PLC design that may upgrade to different PLC solutions without hardware modification.
- AFE031 provides high reliability for PLC applications by using a monolithic integrated circuit with thermal and overcurrent protection.

For more information on each of these devices, refer to the TIDC-HYBRID-WMBUS-PLC product folders.

2.1.1 CC1310

The device is a member of the CC26xx and CC13xx families of cost-effective, ultra low-power, 2.4 GHz and sub 1-GHz RF devices. Low active RF, MCU current, and low-power mode current consumption provide excellent battery lifetime and allow operation on small coin-cell batteries and energy-harvesting applications. The CC1310 device is the first part in a Sub-1 GHz family of cost-effective, ultra low-power wireless MCUs. The CC1310 device combines a flexible, low-power RF transceiver with a powerful 48-MHz Cortex M3 MCU in a platform that supports multiple physical layers and RF standards. A dedicated radio controller (Cortex-M0) handles low-level RF protocol commands that are stored in ROM or RAM, which ensures ultra low-power and flexibility. The low-power consumption of the CC1310 device does not come at the expense of RF performance—the CC1310 device has excellent sensitivity, selectivity and blocking performance. The CC1310 device is a highly integrated, single-chip solution that incorporates a complete RF system and an on-chip DC-DC converter. Sensors may be handled in a low-power manner by a dedicated autonomous ultra low-power MCU that may be configured to handle analog and digital sensors, so the main MCU (Cortex-M3) may maximize sleep time. The CC1310 power, clock management, and radio systems require specific configuration and software handling to operate correctly. This has been implemented in the TI RTOS, and TI recommends that this software framework is used for all application development on the device. The CC1310 includes an Advanced Encryption Standard (AES) engine with 128-bit key support. In addition, the source code offers the complete TI-RTOS and device drivers.
Figure 3 shows the block diagram.
2.1.2 TMS320F28PLC84

The TMS320F28PLC84 PLC processors are optimized to meet the requirements for AMI networks in Smart Grid installations that will use narrowband PLC in the CENELEC frequency band. The CENELEC band is defined to range from 35 kHz to 90 kHz. The F28PLC84 processor is designed to execute the entire PLC protocol stack for the supported industry standards. TI supplies these firmware libraries to execute on the F28PLC84 processor with no additional license fees or royalties. The F28PLC84 processor is also used in PLC data concentrators, which act as neighborhood-area collectors of electricity usage information from multiple end nodes. The F28PLC84 processors are optimized to work with the AFE031 analog front end for the PLC. The AFE031 is an integrated analog front end for narrowband PLC that may drive a transformer-coupled connection to the AC Mains power line. It is ideal for driving high-current, low-impedance lines driving up to 1.9 A into reactive loads. The AFE031 is compliant with CENELEC A, B, C, and D (EN50065-1, -2, -3, -7) frequency bands.

Figure 4 shows the functional block diagram.
2.1.3 AFE031

The AFE031 is a low-cost, integrated, PLC analog front-end device that is capable of capacitive or transformer-coupled connections to the powerline while controlled by a DSP or microcontroller. It is ideal for driving low-impedance lines that require up to 1.5 A in reactive loads. The integrated receiver may detect signals down to 20 µVRMS and is capable of a wide range of gain options to adapt to varying input signal conditions. This monolithic integrated circuit provides high reliability in demanding powerline communications applications. The AFE031 transmit power amplifier operates from a single supply from 7 V — 24 V. At maximum output current, a wide output swing provides a 12-V_{pp} (I_{OUT} = 1.5 A) capability with a nominal 15-V supply. The analog and digital signal processing circuitry operates from a single 3.3-V power supply.

The AFE031 is internally protected against over temperature and short-circuit conditions. It also provides an adjustable current limit. The provided interrupt output indicates the current limit and thermal limit. There is also a shutdown pin that may quickly put the device into its lowest power state. Through the four-wire serial peripheral interface, or SPI™, each functional block may be enabled or disabled to optimize power dissipation. The AFE031 is housed in a thermally-enhanced, surface-mount Power PAD package (QFN-48). Operation is specified over the extended industrial junction temperature range of –40°C to 125°C.

Figure 5 shows the functional block diagram.
3 Getting Started Hardware

The hybrid wireless M-Bus and PLC communications design are built with two standard EVMs: CC1310DK and TMDSPLCKITV4-CEN, as shown respectively in Figure 6 and Figure 7.

The TI design configures as CENELEC-A band in software with a TMDSPLCKITV4-CEN platform for the PLC. Depending on user applications, TIDM-SOMPLC-FCC or TMDSPLCKITV4-ARIB may work with the CC1310DK.

Figure 6. CC1310DK

Figure 7. TMDSPLCKITV4-CEN
3.1 EVM Configuration

The major hardware modification on the hybrid wireless M-Bus or PLC system is to connect the UART pins (UART_TX, UART_RX, and GND) between the CC1310DK and the TMDSPLCKITV4 EVM.

- Figure 8 and Figure 9 show UART pin connections between TMDSPLCKITV4 and CC1310DK.
- The M3:P2-12 (PLC_SCIA_TX) pin in Figure 8 is connected to EM_UART_RX in P412 shown in Figure 9 in the CC1310DK docking board.
- M3:P2-14 (PLC_SCIA_RX) (Figure 8) connects to EM_UART_TX in P412 (Figure 9).
- One of the GND pins in the TMDSPLCKITV4 EVM, as shown in Figure 8, is connected to GND in P412 (Figure 9).

![Figure 8. UART Pins on TMDSPLCKITV4](image)

![Figure 9. UART Pins on CC1310DK Docking Board (SmartRF06 Evaluation Board)](image)
As Figure 10 shows, an additional configuration change is to switch the SW2 position to OFF. Turning off the SW2 blocks UART communication with the mini-USB port in TMDSPLCKITV4, which allows the M3 module to communicate with the external device through the UART without interruptions.

Figure 10. SW2 Position in TMDSPLCKITV4 EVM
4 Getting Started Firmware

This TI design provides a software example (TI_Hybrid_WMBUS_PLC_example) which includes applications for simultaneous transmissions, repeaters, wireless M-Bus lower-layer stacks, and PLC communication host drivers. This section covers details of the example software architecture, and how to build and flash the example project using the TI Code Composer Studio™ (CCS) software.

The first step to building the software example is to install CCS v6.1.2 (or above) with the software update by selecting Help → Check for Updates in the CCS top menu and CC13xx/CC26xx TI-RTOS. The TI-RTOS version to be installed may be checked in the RTSC menu by right clicking on the example CCS project and then Property → General. Once the CCS v6.1.2 and TI-RTOS are installed, the SimpleLink™ wireless MCU examples may be viewed by selecting View → Resource Explorer in the CCS top menu as shown in Figure 11.

4.1 Hybrid_WMBUS_PLC_Project Example

This example project is provided as a working example that may be used as baseline software for end-product development. The example runs on top of TI-RTOS in the ARM™ Cortex-M3. For PLC communication, the default configuration in the example is set to CENELEC-A, TMR ON, and the TX level of 0x20 (maximum). The wireless M-Bus communication is configured in smartrf_setting.c. The pre-compiled binaries are available in the directory of Debug and Debug_SMODE.

The wireless M-Bus may be configured as an S-MODE operation (by choosing the “Debug_SMODE” build configuration) or C-/T-MODE operation (by choosing “debug” build). The major change in the configuration is the operating center frequency as shown in the list below:

- S-mode = 838.3 MHz
- C and T-mode = 838.95 MHz

In the debug build configuration, the C or T-mode may be selected in the codes below in the RFTxTaskFn function.

Figure 12 shows the wireless M-Bus mode configuration.

```c
//wmbus_mode= WMBUS_CMODE;
wmbus_mode= WMBUS_TMODE;
```

Figure 12. Wireless M-Bus C-/T-/S-Mode Configuration
To run the example project with another PLC product based on F28375S (FCC) or F28M35x (ARIB), change the following one-line code in the init_plcHandler() (in g3PLC.c) to `TONEMASK_FCC_FULL_BAND` or `TONEMASK_FCC_ARIB_54`, respectively. The TX power level and TMR configuration may also be changed in the same function.

Figure 13 shows the PLC frequency band.

```
plcHandle.g3ToneMaskSelection = TONEMASK_CENELEC_A_36;
```

**Figure 13. PLC Frequency Band Configuration**

The example project runs simultaneous transmissions (sending data to RF and PLC channels) and RF/PLC repeater (passing received RF or PLC data to a PLC or RF link.) Depending on the end-product requirement, each feature may be disabled by disabling the macros ("SIMULTANEOUS_RF_PLC" and "RF_PLC_REPEATER") defined in hybrid_main.c.

Figure 14 shows the overall software architecture that consists of five tasks shown in the following list:

- uartRXTask
- PLCStateMachineTask
- RFTxTask
- PLCTxTask
- applicationTask

![Figure 14. Hybrid WMBUS/PLC Example Software Architecture](image-url)
4.1.1 uARTRxTask

The uartRXTask processes PLC host messages that are received from the C2000 PLC device. The task waits for a 6-byte PLC host message header that contains a host message type, payload length, and header CRC. If the CRC passes, the task extracts the remaining bytes including payload CRC, payload sub-header, and payload. If the payload CRC passes and the message details confirmation information, then the task passes the message to the PLCStateMachineTask. If "RF_PLC_REPEATER" is enabled and the received message contains application data, then this task passes the received data to RFTxTask.

4.1.2 PLCStateMachineTask

The PLCStateMachineTask maintains a G3-PLC service node state machine. When the power is on, the PLCStateMachine task starts to initialize G3-PLC with the default configuration and joins the G3-PLC network once the G3-PLC DC is detected. When all steps have completed, the task changes the state machine to a NORMAL state, which allows the PLCTxTask to start data transmissions.

The details of the G3-PLC host message sequences may be found in Section 4.2. This example covers basic message sequences for G3-PLC operation.

4.1.3 RFTxTask

The RFTxTask waits for the mailbox message of “SEND_RF_DATA”. When the task receives the mailbox message, it constructs the application data in a wireless M-Bus packet and sends the wireless M-Bus packet to the wireless M-Bus PHY. The task then changes to the receive state. If the wireless M-Bus is working only for TX mode, the receive-related commands may be removed.

4.1.4 PLCTxTask

The PLCTxTask waits for the mailbox messages of “SEND_PLC_DATA” and “RETX_PLC_DATA”. If the task receives one of the mailbox messages, it sends the data over UART to the PLC C2000 device for PLC transmissions and then copies the data into PLC_HoldQueue to handle re-transmissions. The RETX_PLC_DATA message may be received when the transmission fails due to PLC communication errors or the task does not receive a confirmation message until timeout. When re-transmission happens, the task sends the data in the PLC_HoldQueue through UART.

4.1.5 applicationTask

The applicationTask emulates the application data source. This task creates 100-byte data, stores the data in the TX queue, and signals to both the RFTxTask and PLCTxTask for simultaneous transmissions. This event happens every five seconds with the default configuration.

4.1.6 rxDoneCallback

This function is called when wireless M-Bus stacks receive packets. Once the callback receives a packet, it decodes the packet based on the wireless M-Bus mode. If the RF_PLC_REPEATER is enabled, the received packet is passed to the PLCTXTask through the mailbox.

4.1.7 LED Configuration

The example project has four activated light-emitting diodes (LEDs) to trace software activities. The LED configuration only works for the CC1310DK EVM.

Table 1 lists the LED number mapping to the specific software activity.

<table>
<thead>
<tr>
<th>LED NUMBER</th>
<th>BEHAVIOR MAPPING TO SOFTWARE ACTIVITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ON when joined to PLC network (ready to send/receive data)</td>
</tr>
<tr>
<td>2</td>
<td>Toggling for PLC state machine change</td>
</tr>
<tr>
<td>3</td>
<td>Toggling for PLC TX/RX</td>
</tr>
<tr>
<td>4</td>
<td>Toggling for wireless M-Bus TX/RX</td>
</tr>
</tbody>
</table>
4.2 **Build Hybrid_WMBUS_PLC_Project Example Using CCS™**

The example project may be built with CCS IDE v6.1.2 (or above). The project file may be opened in the TI_Hybrid_WMBUS_PLCExample directory and may be built with the Debug or Debug_SMODE build configuration. The screen capture of the project is shown in Figure 15. Once the compilation is successful, the binary file (Hybrid_WMBUS_PLC_Project.out) will be generated under Debug/ or Debug_SMODE/.

Figure 15 shows the screen capture of the Build Hybrid_WMBUS_PLC Project Example.

![Figure 15. Build Hybrid_WMBUS_PLC Project](image)

4.3 **Flashing Binaries Using CCS™**

This section explains the F28PLC84 (for G3-PLC) and CC1310 (for Hybrid wireless M-Bus/PLC application devices) flash software binary procedure.

4.3.1 **Flashing Hybrid Wireless M-Bus/PLC Binary to CC1310 Using CCS™**

This section explains how to flash the Hybrid wireless M-Bus/PLC example binary on the CC1310 device using CCS. The instructions are in the following list:

1. Connect the USB cable to the CC1310DK.
2. Select **View → Target Configurations** and create a new target configuration as shown in Figure 16.
3. Launch the target configuration and connect to the Cortex_M3_0 core as shown in Figure 17.

4. Select Run → Load → Load Program and flash “Hybrid_WMBUS_PLC_Project.out” binary under the Debug directory.

4.3.2 Flashing PLC Binary to TMS320F28PLC84

The step-by-step procedure may be found in Section 7.1 (with C2Prog tool) and Section 7.2 (with the CCS tool) in the System on Module for G3 Power Line Communication (CENELEC Frequency Band) design guide [4]. The latest G3-PLC software may be found in TI-PLC-G3-CENELEC-SN-F28PLC84.
5  **Hybrid Wireless M-Bus/PLC Test**

The goal of the hybrid wireless M-Bus/PLC test is to prove the wireless M-Bus/PLC repeater functionality with a 3-node set up that includes one wireless M-Bus, one PLC and one hybrid wireless M-Bus/PLC node.

5.1  **Test Setup**

To run the Hybrid RF/PLC test, a CC1310DK and TMDSPLCKITV4-CEN is required. Both EVMs are orderable in the TI store at TI.com. 

Table 2 lists the required tools and software to run the hybrid wireless M-Bus/PLC test.

<table>
<thead>
<tr>
<th>DEVICE</th>
<th>EVM</th>
<th>HARDWARE MODIFICATION</th>
<th>FLASH Firmware</th>
<th>GUI TOOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless M-Bus only</td>
<td>CC1310DK</td>
<td>No</td>
<td>Yes (echo-back wireless M-Bus binary (1) Section 4.3.1)</td>
<td>No (Running as stand alone mode)</td>
</tr>
<tr>
<td>PLC only</td>
<td>TMDSPLCKITV4-CEN</td>
<td>No</td>
<td>Yes (Section 4.3.2)</td>
<td>Yes (Zero-configuration GUI (2))</td>
</tr>
<tr>
<td>Hybrid wireless M-Bus + PLC</td>
<td>CC1310DK TMDSPLCKITV4-CEN</td>
<td>Yes</td>
<td>Yes (Section 4.3.1 and Section 4.3.2)</td>
<td>No (Running as stand alone mode)</td>
</tr>
</tbody>
</table>

(1) The echo-back wireless M-Bus binary (Hybrid_WMBUS_PLCL_Project_echoback.out) may be found in the Debug/ or Debug_SMODE/ directory. Flashing instructions are given in Section 4.3.1.

(2) Zero-Configuration GUI is used to run PLC node as a mini-DC to start the G3-PLC network. The G3-PLC software package will install the GUI automatically.

The echo-back wireless M-Bus binary is for demo purposes and the pre-built binaries are available in Debug/ or Debug_SMODE/. The binary may be built in the CCS project by configuring the macro definitions shown in Figure 18. The echo-back binary sends the received application packet back after stripping out UDP/IPv6 headers on the packet.

Figure 18. ECHO_BACK_MODE Configuration
5.2 Running Hybrid Wireless M-BUS/PLC Test

Figure 19 shows a 3-node test set-up. The PLC-only node runs with the zero-configuration GUI tool. The hybrid wireless M-Bus/PLC node and wireless M-Bus echo-back node run in standalone mode.

For the hybrid wireless M-Bus/PLC test, the PLC-only node is configured as G3-PLC mini-DC node. The wireless M-Bus echo-back node may run as an echo-back mode to send back the received wireless M-Bus packet to the hybrid node.

Once the power is on, the hybrid wireless M-Bus/PLC node starts to join to the PLC mini-DC (PLC only node) as the G3-PLC service node. The wireless M-Bus stacks in the hybrid node does not require a joining process. Once joined to the PLC network, the PLC-only node (running as mini-DC) may initiate echo-back data transfer.

Figure 20 shows the details of the data flow.

1. The PLC node sends UDP/IPv6 data through the power line.
2. The hybrid wireless M-Bus/PLC node receives the data, and passes the data to the wireless M-Bus echo-back node through the RF path.
3. The wireless M-Bus echo-back node takes the UDP/IPv6 header from the received data and then sends it back to the Hybrid wireless M-Bus/PLC node through the RF path.
4. The hybrid node adds a UDP/IPv6 header on the received data because the G3-PLC only accepts IPv6 packets.
5. The hybrid node sends the data to the PLC node through the power line.

5.2.1 Test Procedure

This section covers the step-by-step procedure for running the hybrid wireless M-Bus/PLC testing.

1. Start the PLC only node as a mini-DC (Refer to Steps 1 – 4 in Section 5.2.2).
   Turn on the Wireless M-Bus echo-back node and the hybrid wireless M-Bus/PLC node to start standalone mode.
   Note: For power cycle EVMs, switch both “Source” and “Power” OFF and then ON.
2. Once the hybrid wireless M-Bus/PLC node is joined to the mini-DC, the LED1 on the hybrid wireless M-Bus/PLC EVM will be ON. The GUI window in the mini-DC will show the joining information (Refer to Step 5 in Section 5.2.2).
3. Start data transfer testing by clicking “Start Test” in the GUI window in the mini-DC (Refer to Step 6 in Section 5.2.2).
5.2.2 PLC Only Node Setup

This section covers how to run the PLC only node as a mini-DC with GUI.

1. Connect the PLC only node to the PC and open the intermediate GUI.
2. Set a unique long address for each device by using “Set System Config”.

![Figure 21. Set System Configuration](image-url)
3. Start a device as a mini-DC by selecting Functions → Start Base Node.
4. In the pop-up window of the G3 Base Node, click "Start Network".

5. Once the hybrid wireless M-Bus/PLC node is joined, the IPv6 information for the joined node will be available.
6. Set the “Max Data Packet Size” to 184 due to the maximum size limitation of the wireless M-Bus specification. Then, start data echo-back testing by selecting “Start Test”.

Figure 26. Start Data Echo-Back Test
5.3 Hybrid Wireless M-Bus/PLC Test Results

This section shows the hybrid wireless M-Bus/PLC test results to verify wireless M-Bus/PLC repeater functionality.

Figure 27 shows the echo-back test results. For the testing, mini-DC configures minimum packet size to 6B, maximum packet size to 184B, test cycles to 1000 cycles, and the packet interval to 2000 msec. The packet size increases by 1B every transmission. As shown in the result, all the data is successfully echo-backed through the RF and PLC mixed paths, which proves that the hybrid wireless M-Bus/PLC routes the PLC and wireless M-Bus packets between the PLC only and wireless M-Bus only nodes.

![Figure 27. Hybrid Wireless M-Bus and PLC Echo-Back Test Result](image_url)
6 Design Files

6.1 Schematics
To download the schematics, refer to the TIDC-HYBRID-WMBUS-PLC design files.

6.2 Bill of Materials
To download the bill of materials (BOM), refer to the TIDC-HYBRID-WMBUS-PLC design files.

6.3 Layout Prints
To download the layout prints for each board, refer to the TIDC-HYBRID-WMBUS-PLC design files.

6.4 Gerber Files
To download the Gerber files, refer to the TIDC-HYBRID-WMBUS-PLC design files.

6.5 Assembly Drawings
To download the assembly drawings, refer to the TIDC-HYBRID-WMBUS-PLC design files.

7 Software Files
To download the software files, refer to the TIDC-HYBRID-WMBUS-PLC design files.

8 References
2. Texas Instruments, *MS320F28PLC8x Power Line Communications (PLC) Processors*, TMS320F28PLC83/4 Datasheet, SPRS802
3. Texas Instruments, *Powerline Communications Analog Front-End*, TMS320F28PLC83/4 Datasheet, SBOS551

9 Terminology
1. PLC: Power-line communication
2. RF: Radio frequency
3. TMR: Tone map request
4. DC: Data concentrator
5. VCU: Viterbi/complex math unit
6. AMI: Advanced metering infrastructure
7. AFE: Analog front end

10 About the Author
WONSOO KIM is a system engineer at Texas Instruments, where he is responsible for driving system solutions for Smart Grid applications, defining future requirements in the TI product roadmap, and providing system-level support and training focused on communication software and systems for Smart Grid customers. He received his Ph.D. in Electrical and Computer Engineering from the University of Texas at Austin in Austin, TX.
IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated (‘TI’) reference designs are solely intended to assist designers (‘Designer(s)’) who are developing systems that incorporate TI products. TI has not conducted any testing other than that specifically described in the published documentation for a particular reference design.

TI’s provision of reference designs and any other technical, applications or design advice, quality characterization, reliability data or other information or services does not expand or otherwise alter TI’s applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such reference designs or other items.

TI reserves the right to make corrections, enhancements, improvements and other changes to its reference designs and other items. Designer understands and agrees that Designer remains responsible for using its independent analysis, evaluation and judgment in designing Designer’s systems and products, and has full and exclusive responsibility to assure the safety of its products and compliance of its products (and of all TI products used in or for such Designer’s products) with all applicable regulations, laws and other applicable requirements. Designer represents that, with respect to its applications, it has all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. Designer agrees that prior to using or distributing any systems that include TI products, Designer will thoroughly test such systems and the functionality of such TI products as used in such systems.

Designers are authorized to use, copy and modify any individual TI reference design only in connection with the development of end products that include the TI product(s) identified in that reference design. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of the reference design or other items described above may require a license from a third party under the patents or other intellectual property of TI.

TI REFERENCE DESIGNS AND OTHER ITEMS DESCRIBED ABOVE ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY DESIGNERS AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS AS DESCRIBED IN A TI REFERENCE DESIGN OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TI's standard terms of sale for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm) apply to the sale of packaged integrated circuit products. Additional terms may apply to the use or sale of other types of TI products and services.

Designer will fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of Designer’s non-compliance with the terms and provisions of this Notice.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265

Copyright © 2016, Texas Instruments Incorporated